
Welcome to PCoIP Software Client for Windows

Welcome to the Teradici PCoIP® Software Client for Windows Administrators' Guide.

PCoIP Software Clients are applications that establish PCoIP sessions with remote Windows or

Linux desktops. Connections can be made remote desktops and workstations via either PCoIP

Agents (component of Cloud Access Software) or Remote Workstation Cards.

This guide explains how to install, configure, and use the PCoIP Software Client for Windows. It

includes client system requirements and information on host dependencies.

Welcome to PCoIP Software Client for Windows
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Who Should Read This Guide?

This guide is intended for administrators and users who install, configure, or use the Teradici

PCoIP® Software Client for Windows.

Understanding terms and conventions in Teradici guides

For more information on the industry specific terms, abbreviations, text converntions, and graphic symbols used in

this guide, see Using Teradici Product and Component Guides and the Teradici Glossary.
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What's New in This Release

The PCoIP Software Client for Windows 21.07 introduces the following features and

enhancements:

Webcam Support

USB webcams now supported in a PCoIP session when connecting to PCoIP Agents for Windows.

Use webcams with conference applications such as Microsoft Teams or Zoom in the remote

desktop. For more information on this, see Webcam Support.

Security and Stability Updates

Increased security and stability updates and enhancements around the PCoIP Client.

TLS 1.1 Deprecation

The PCoIP Software Client for Windows will no longer negotiate PCoIP connections using TLS 1.1.

What's New in This Release
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Additional Documentation

The following guides contain additional information relevant to PCoIP systems and PCoIP

Software Clients:

• For more information about Teradici Cloud Access Software, including detailed information on

included PCoIP components as well as Teradici All Access plans, see the Teradici Cloud

Access Architecture Guide.

• For more information about Teradici PCoIP agents, which are required on remote virtual

machines, see the following pages:

◦ Teradici PCoIP Standard Agent for Windows

◦ Teradici PCoIP Graphics Agent for Windows

◦ Teradici PCoIP Standard Agent for Linux

◦ Teradici PCoIP Graphics Agent for Linux

• For information about Teradici PCoIP Host Software, which is required on remote

workstations using a Teradici PCoIP Remote Workstation Card, see the following pages:

◦ PCoIP Host Software for Windows

◦ PCoIP Host Software for Linux

Additional Documentation

© 2021 Teradici 4

http://www.teradici.com/web-help/pcoip_cloud_access_arch/current/
http://www.teradici.com/web-help/pcoip_cloud_access_arch/current/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/windows/current/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/current/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/linux/current/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/current/
http://www.teradici.com/web-help/pcoip_host_software/windows/4.3.1/
https://www.teradici.com/web-help/pcoip_host_software/linux/4.8/


System Requirements

The following table outlines the system requirements for the PCoIP Software Client for Windows:

*For details on feature limitations between PCoIP Software Clients and PCoIP Remote Workstation

Cards, see here. 

Hardware System Requirements

For different display configurations Teradici recommends certain processor and RAM

combinations:

• For up to dual 1920 x 1080 display configuration Teradici recommends 1.6 GHz dual core

processor or higher with at least 4 GB RAM.

• For up to dual 4K/UHD Teradici recommends a 3.0 Ghz quad core processor or higher with at

least 2 x 4 GB RAM. 

System Version Required

PCoIP Software Client Operating

Systems
• Windows 10 (64-bit)

Other operating systems are also supported. For information and

documentation on these, see here.

Compatible PCoIP Agents All PCoIP Agents and versions should work. Teradici recommends using the

same version of PCoIP Agent as PCoIP Client.

Compatible PCoIP Remote

Workstation Cards*

TERA22x0 with firmware 20.04 and PCoIP Host Software for Windows or

Linux 20.04.

IPv Support IPv4 and IPv6 supported

System Requirements
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Audio Support

Stereo audio output and mono audio input are supported and enabled by default.

The PCoIP Client provides an enhanced audio and video synchronization (A/V Sync) feature that

provides improved full-screen video playback, reducing the difference in delays between the audio

and video channels and smoothing frame playback on the client. This improves lip sync and

reduces video frame drops for movie playback. This feature introduces a small lag in user

interaction responsiveness when enabled. Using enhanced audio and video synchronization will

reduce the maximum frame rate. 

Audio input devices should not be bridged to the remote session. Audio input devices are locally

terminated and utilize local OS audio drivers. A bluetooth headset can be supported locally, but

cannot be bridged.

For more information on the A/V Sync feature, see Enhanced Audio and Video Synchronization.

Audio Support
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Displays

The PCoIP Client supports a maximum of four displays and a maximum resolution of 4K UHD

(3840×2160).

Monitors can be arranged in a vertical line, a horizontal line, or as a 2×2 box display. They can be

used in any standard rotation (0°, 90°, 180°, or 270°), with any monitor as the primary display.

Note: Using multiple high-resolution displays

Systems with multiple high-resolution displays, such as quad 4K UHD topologies, require powerful system

infrastructure. Be sure to use a system with sufficient bandwidth and client capability to support your required display

topology.



Important: Attaching monitors to the host machine in not supported

PCoIP client supports a maximum of four displays. Attaching extra monitors to the host machine will conflict with

client display topologies.



Displays
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Supported Installer Languages

The PCoIP Client installer supports the following languages:

• French

• German

• Spanish

• Simplified Chinese

• Traditional Chinese

• Japanese

• Portuguese

• Italian

• Korean 

• Russian

• Turkish

Supported Installer Languages
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PCoIP Ultra

The PCoIP Client provides support for PCoIP Ultra, the latest protocol enhancements from

Teradici. PCoIP Ultra is optimized for truly lossless support with bit-exact color accuracy and

preservation of content detail at the highest frame rates.

PCoIP Ultra protocol enhancements propels our industry-recognized performance into the future

of remote computing, with faster, more interactive experience for users of remote workstations

working with high-resolution content.

PCoIP Ultra enhancements are controlled on the PCoIP Agent. There is no configuration required

on the PCoIP Client.

For additional detail on PCoIP Ultra technical requirements for various use cases and

troubleshooting steps, refer to KB 2109: PCoIP Ultra Troubleshooting.

When to Enable PCoIP Ultra

PCoIP Ultra is apporpriate for users with the following requirements:

Auto Offload: Achieves the best balance between color accuracy and network efficiency. This

setting is appropriate for work-from-home or WAN content creators who require optimized delivery

of high resolution content, including video playback, while still achieving build-to-lossless color

accuracy.

CPU Offload: Provides efficient scaling across multicore CPUs, leveraging AVX2 instruction sets.

Appropriate for users that require CPU-optimized delivery of 4K UHD, high-framerate video

playback and build-to-lossless color accuracy. It is also useful when GPU encoding resources must

be reserved for video encoding applications, typically in LAN environments.

PCoIP Ultra is appropriate for specific use cases

For most users, the default PCoIP protocol will provide the best possible experience. Carefully review the

recommended use cases in the next section to determine whether you should enable it.



PCoIP Ultra
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GPU optimization Offload: PCoIP encoding is always offloaded to a GPU. Appropriate for users

who demand the highest possible CPU efficiency.

For all other scenarios, Teradici recommends that you leave PCoIP Ultra disabled.

Requirements

To take advantage of PCoIP Ultra, you need:

• A PCoIP Agent (any type), 21.03 or later

• A PCoIP Software Client (any type), 21.03 or later

• The CPUs on both the agent and the client machines must support the AVX2 instruction set.

Enabling PCoIP Ultra

In order to enable PCoIP Ultra features you need to turn on GPO variables in the PCoIP Agent. For

information on enabling this with Linux, see Enabling PCoIP Ultra for Linux. For information on

enabling this with Windows, see Enabling PCoIP Ultra for Windows. 

Auto-Offload with PCoIP Ultra

The auto-offload feature with PCoIP Ultra enables users to allow PCoIP Ultra to select the best

protocol, whether that is CPU or GPU, based on display rate change. CPU Offload is used by

default to provide the best image fidelity, GPU Offload is used during periods of high display

activity to provide improved frame rates and bandwidth optimization. This setting is only effective

if the remote host and client endpoints are capable of both CPU and GPU Offload. You can select

this option when you are enabling PCoIP Ultra. 

For information on how to do this, see PCoIP Ultra - Windows, and PCoIP Ultra - Linux.

PCoIP Codec Indicator

When enabling PCoIP Ultra there will be an onscreen indicator at the bottom left corner of the

screen. PCoIP Ultra CPU optimization is indicated with a dark blue dot. PCoIP Ultra GPU

optimization is indicated by a magenta dot. To disable this codec indicator create the following

Requirements
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registry key and set to 0: 

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Teradici\PCoIP\pcoip_admin_defaults\

pcoip.codec_indicator (DWORD)

PCoIP Codec Indicator
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Printing Support

When a local printer is visible to a client computer by USB connection or local network connection,

it may be possible to print from the host machine. Refer to the following table for local printing

support.

Cloud printing is available from all clients if supported by the desktop system and correct PCoIP

Agent.

The following are the printing options available with the PCoIP Client:

• Local USB Printing: Printing to a USB printer locally attached to the Client device.

• Remote Network Printing: Enables printing to a network printer on the nost machines

network. Not suitable in situations here the PCoIP Software Client device is not on the same

network as he host device.

• Cloud Printing: This is access to external Cloud Services that are set-up on your local

workstation and network. Once these services have been correctly configured they can be

used by the PCoIP Software Client.

• Local Network Printing: Enables printing from the host machine to a printer in the PCoIP

Client machine's local area network. This method is suitable for printing when host and client

are not on the same network or for identifying and printing to local printers that exist in multi-

site organizations.

The PCoIP Standard Agent for Linux does not support local printing on remote clients.

PCoIP Agent for Windows PCoIP Agent for Linux

Local USB Printing  

printer is connected to a USB port on the client computer

—

Remote Network Printing  —

Local Network Printing  —

Cloud Printing  —

Printing Support
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Local, network, and cloud printers are supported in various ways:

• Linux hosts can print to any printer on the host machine’s local area network.

• If your host host workstation has access to the Internet, cloud-based printing is supported

through cloud-printing services such as Google Cloud Print and HP Mobile Printing.

Printing Support
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USB Support

PCoIP Clients supports redirecting USB devices to a remote session. Administrators can set rules

governing allowed and disallowed devices, device classes, or device protocols. 

Isochronous USB device support

Some USB devices with time-sensitive information, such as webcams, are supported when

connecting to the PCoIP Agent for Windows.

Additionally, Teradici's technology partners provide solutions to expand peripheral support. For

more information, look for partners listed under Peripherals on the Teradici Technology Partners

page.S

Important: USB support is enabled by default

USB bridging is enabled by default. If you want to restrict or disable USB support, you can globally disable or set rules

governing USB behavior via GPO settings on the PCoIP Agent.



USB Redirection

USB redirection is only intended to be used with a single instance of the PCoIP Software Client. Launching a second

instance of the PCoIP Software Client while USB devices are redirected from another client may not work as expected.



USB Support
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Wacom Tablet Support

The Software Client for Windows supports Wacom tablets in two configurations: bridged, where

peripheral data is sent to the desktop for processing, and locally terminated, where peripheral data

is processed locally at the Software Client.

Locally terminated Wacom tablets are much more responsive and tolerate low latency

connections. 

Whether the Wacom tablet is locally terminated or bridged, the process of remoting the USB

device is the same, you need to click connect in the USB menu or auto forward the device. If local

termination is supported for the particular device, it will automatically be chosen over bridging. For

more information on this, see Local Termination Blacklist.

Locally Terminated Wacom Tablets

Locally-terminated tablets have greatly improved responsiveness, and tolerate higher-latency

(including 25ms and higher) networks.

Local termination requires:

• A Standard agent or Graphics agent for Windows version 21.01 or higher.

• A Standard agent or Graphics agent for Linux version 21.01 or higher.

The following Wacom tablet models have been tested and are supported with local termination.

PCoIP client support for locally terminated Wacom tablets and the Software Client for Windows

PCoIP

Standard

Agent for

Linux

PCoIP

Graphics

Agent for

Linux

PCoIP

Standard

Agent for

Windows

PCoIP

Graphics

Agent for

Windows

PCoIP Remote

Workstation

Card

Intuos Pro Small

PTH-460

    —

Wacom Tablet Support
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Bridged Wacom Tablets

Bridged Wacom tablets are supported only in low-latency environments. Tablets in network

environments with greater than 25ms latency will show reduced responsiveness and are not

recommended. A HID Local Termination Blacklist has been added to override the preferred local

termination mode. Devices on the blacklist would be bridged to the remote desktop. For more

information, see Local Termination Blacklist.

PCoIP

Standard

Agent for

Linux

PCoIP

Graphics

Agent for

Linux

PCoIP

Standard

Agent for

Windows

PCoIP

Graphics

Agent for

Windows

PCoIP Remote

Workstation

Card

Intuos Pro Medium

PTH-660

    —

Intuos Pro Large

PTH-860

    —

Cintiq 22HD

DTK-2200

    —

Cintiq Pro 24 -

 Pen Only

DTK-2420

    —

Cintiq 22

DTK-2260

    —

Cintiq 22HDT -

 Pen & Touch

DTH-2200

— — — — —

Cintiq Pro 24 -

 Pen & Touch

DTH-2420

    —

Cintiq Pro 32 -

 Pen & Touch

DTH3220

    —

Bridged Wacom Tablets
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The following Wacom tablet models have been tested and are supported on a PCoIP Software

Client for Windows.

PCoIP client support for bridged Wacom tablets and the Software Client for Windows

PCoIP

Standard

Agent for

Linux

PCoIP

Graphics

Agent for

Linux

PCoIP

Standard

Agent for

Windows

PCoIP

Graphics

Agent for

Windows

PCoIP Remote

Workstation

Card

Intuos Pro Small

PTH-460

    —

Intuos Pro Medium

PTH-660

    —

Intuos Pro Large

PTH-860

    —

Cintiq 22HD

DTK-2200

    —

Cintiq Pro 24 -

 Pen Only

DTK-2420

    —

Cintiq 22HDT -

 Pen & Touch

DTH-2200

    —

Cintiq Pro 24 -

 Pen & Touch

DTH-2420

    —

Cintiq Pro 32 -

 Pen & Touch

DTH3220

    —

Bridged Wacom Tablets
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Known Issues with Wacom Tablets and Functionality

Whilst testing and developing the compatibility of Teradici Cloud Access Software with different

Wacom tablets, certain performance issues arise. The following is a list of the current known

issues with certain Wacom tablets:

• The touch feature only works on the Cintiq Pro 32 Pen & Touch (DTH-2420). It does not work

on any other bridged and locally terminated devices across all platforms.

• ExpressKey Remote does not work on the Wacom Cintiq Pro 32 (DTH-3220). You should still

remote to this device when remoting to the Wacom tablet.

• There are cursor limitations when working with the Wacom Cintiq 22HD (DTK-2200) and

Wacom Cintiq Pro 24 (DTK-2420) for both bridged and locally terminated devices across all

platforms.

• There is a issue with the control buttons on the Wacom Cintiq Pro 32 (DTH-3220) device. The

buttons do not function on locally terminated devices across all platforms.

• PCoIP Clients are not compatible with NoMachine and No Machine USB drivers. For

information on how to uninstall NoMachine USB drivers, see here.

Wacom Cintiq Pro 32 Tablet Selection

The Wacom Cintiq Pro 32 shows up as multiple devices in the USB menu. You should remote the

following USB devices as outlined in the image below to remote to this Wacom tablet:

• ExpressKey Remote

• Cintiq Pro 32 Touch

• Wacom Cintiq Pro 32

Known Issues with Wacom Tablets and Functionality
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Wacom Cintiq Pro 32 Tablet Selection
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SpeechMike Support

SpeechMike support has been added to the PCoIP Software Client for Windows 20.10. 

SpeechMike is an isochronous USB device and requires USB ISO device support to be enabled.

The HID checkmark needs to be selected for the feature to work.

On the Windows VM agents set pcoip.enable_unsupported_iso_devices=1, using the command

line below:

On the PCoIP Client machine, set pcoip.usb_allow_unsupported_device=1 using the command

line below:

REG ADD HKLM\Software\Policies\Teradici\PCoIP\pcoip_admin_defaults /v 
pcoip.enable_unsupported_iso_devices /t REG_DWORD /d 1

REG ADD HKLM\Software\Policies\Teradici\PCoIP\pcoip_admin_defaults /v 
pcoip.usb_allow_unsupported_device /t REG_DWORD /d 1

SpeechMike Support
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Webcam Support

PCoIP Software Client for Windows now supports USB webcams when connecting to a PCoIP

Agent for Windows. USB webcams can now be used while in the remote desktop, including with

applications such as Microsoft Teams or Zoom.

For detailed information which models have been tested and the performance metrics associated

with these models see here. This knowledge base article also deals steps on how to test and verify

other webcam models.

As of 21.07, this feature is enabled by default.

Requirements

Webcam support in Cloud Access Software requires the following:

• PCoIP Software Client for Windows or PCoIP Software Client for Linux, 21.07+

• PCoIP Standard Agent for Windows or PCoIP Graphics Agent for Windows, 21.03+

• USB-attached webcam.

Notes and Limitations

• Webcams must be connected via USB. Webcams that are not USB, such as embedded laptop

webcams, are not supported.

• Linux agents are not supported.

• PCoIP Software Client for macOS is not supported.

Setup

On the PCoIP Software Client, connect the webcam as described in the following sections:

• PCoIP Client for Windows: USB Bridging of Webcams.

Webcam Support
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• PCoIP Client for Linux: USB Bridging of Webcams.

Setup
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Console Game Controller Support

PCoIP Software Clients are compatible with the following console game controllers:

• PS4

• PS5

• Logitech F310 gamepad

The following console game controllers are supported with the PCoIP Zero Client:

• Xbox One 2015

• Xbox One

• Xbox One S

• Xbox One Bt

• Xbox One Elite

Console Game Controller Support
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Relative Mouse Support

Relative Mouse is a method of translating mouse movements as a delta from the last mouse

position rather than a move to an absolute position on the screen. This type of mouse control is

used in many CAD/CAM, Visual Effects and First-Person Gaming software. In a CAD program you

may want to control an objects orientation in 3-D with mouse movements. Moving the mouse to

the left or right rotates the object around the Z-axis, and moving the mouse up or down rotates the

object around the X-axis. As you continue to move the mouse left the object continues to rotate

about the axis, and the rotation is not bounded by the mouse stopping at the boarders of the

screen. 

In fact while in relative mouse mode, the mouse cursor is not visible as the position of the mouse

is not important, the mouse is only being used to control movements - up/down or left/right. 

Applications that use relative mouse movements generally provide methods for entering or exiting

relative mouse mode, for instance clicking on an object with the middle button. While the middle

button is held down the object may be controlled using relative mouse movements. 

This feature is currently supported with the following components:

The following components do not support this feature:

• PCoIP Standard Agent for Linux

• PCoIP Graphics Agent for Linux

Relative Mouse Support Supported

PCoIP Software Client for Windows 

PCoIP Software Client for Linux 

PCoIP Tera2 Zero Client 6.4 (Requires Configuration to enable) 

PCoIP Standard Agent for Windows 

PCoIP Graphics Agent for Windows 

Relative Mouse Support
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Enabling Relative Mouse Support

To enable relative mouse support create a pcoip_client_settings.txt file in %localappdata%

\Teradici and run the following command:

You are also required to enable relative mouse support on the PCoIP Agent also. For instructions

on this, see here

pcoip.enable_relative_mouse=1

Enabling Relative Mouse Support
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Installing the Software Client for Windows

In this section, you will learn how to install and uninstall the Software Client for Windows for

Windows.

Before You Begin

Before installing the Software Client for Windows:

• You must be logged in as an administrator to the client machine.

• Close any existing Software Client for Windows applications.

Installing the Software Client

You can install the Software Client for Windows with the provided Windows installation wizard or

from the command line.

To install the Software Client for Windows using the wizard:

1. Double-click the Software Client for Windows installer executable (pcoip-client.exe) to begin

installation.

2. Follow the prompts to specify installation locations, and to agree to any licenses.

3. Click Finish to complete installation and close the installer.

To install the Software Client for Windows silently from the command line:

• Install the Software Client for Windows silently by running the installer executable from the

command line:

Microsoft Visual C++ Redistributable package

The libraries in this package are required by the Software Client for Windows. If they aren't already installed, a

wizard will launch and install them for you.



Installing the Software Client for Windows
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where  is the full path to the folder containing the pcoip-client.exe

executable.

Uninstalling the Software Client

To uninstall the Software Client for Windows:

1. Click Start (or Search Windows for Windows 10).

2. In the search box, type Add or remove programs and press Enter.

3. Select Teradici PCoIP Client from the list of programs.

4. Click the Uninstall/Change button above the list.

Installing the Software Client in Silent Mode

The following section outlines how to install the PCoIP Software Client in silent mode. Please note

that you must authorize the application to run in silent mode. To install the PCoIP Software Client

on Windows use the  switch on the command line when launching the installer in the Windows

CMD Prompt as outlined in the following example:

<path-to-installer>\pcoip-client.exe /S`

<path-to-installer>

Silent installation uses default options

The silent installer uses default settings and options. For example, a silent installation won't create a desktop

shortcut.



Troubleshooting PCoIP Session Connection Issues

If you encounter issues with your PCoIP Session, please see the following KB article: https://help.teradici.com/s/

article/1027. This article details some potential causes and fixes for common connection issues. 



/S

C:\Downloads\pcoip-client_21.03.0.exe /S

Uninstalling the Software Client
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Using the PCoIP Software Client

After installing a PCoIP Software Client on your client machine, you can connect to the following

PCoIP solutions or products or hosts:

• Teradici PCoIP Graphics Agent or PCoIP Standard Agent installed as part of Teradici Cloud

Access Software.

• Teradici PCoIP Remote Workstation Card and Teradici PCoIP Host Software installed in a

Windows or Linux workstation.

• If you want to connect to the PCoIP Remote Workstation Card you need to install the PCoIP

Remote Workstation Card Agent along with PCoIP Host Software.

Using the PCoIP Software Client
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Connecting to Virtual Machines

You can connect to virtual Windows or Linux hosts that have a PCoIP Standard Agent or PCoIP

Graphics Agent installed. Connections can be made directly to individual host machines, or via a

connection broker in managed deployments.

To connect to a remote workstation or virtual desktop:

1. Double-click the PCoIP Client desktop icon, alias, or program file PCoIPClient to launch the

application.

2. In the Host Address or Code field, enter one of the following:

• For direct connections, provide the address of the host machine.

• For managed connections, provide the address of the connection manager. 

If you want to save this connection later for easy recall, enter a name in the Connection Name

field. You will save the connection in step 5.

3. Click NEXT.

Connecting to Virtual Machines
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4. On the next screen, select your domain from the dropdown list, enter your user name and

password for the desktop, and then click LOGIN. 

About the Security Padlock Indicator

The login screen displays a red padlock indicator when accessing a PCoIP agent desktop that uses default self-

signed certificates. The icon indicates that the software’s certificate is not signed by a trusted certificate

authority (CA). You can use your own CA to create a certificate and then install the appropriate files at each end.

If the client trusts your internal CA, a green padlock icon displays on the screen instead. To learn more about

certificates, see the PCoIP agent administrators guides listed in the Teradici Cloud Access Architecture Guide.



To connect to a remote workstation or virtual desktop:
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5. If your login is successful, the following screen appears with a list of available desktops: 

6. Click Connect to connect to the selected desktop.

A short interface delay is normal

When a session is first connected, it may take a few seconds before you can take control of the keyboard and mouse.

This is normal behavior.



Single-desktop users

If a user only has access to a single desktop, that desktop is automatically selected and the connection is initiated

immediately. These users are not presented with a desktop selection screen.



To connect to a remote workstation or virtual desktop:
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Advanced Saved Connections

Administrators can save more complex desktop connections with the PCoIP Client. The following

section outlines the connection scenarios that can be saved, and outlines the potential benefits of

doing so.

Saved Broker Address

This configuration enables you to create a saved connection where only the broker address is

saved. You need to enter your username when connecting to a remote host. Enter the host

address and name the connection, then click SAVE.

Pre-configured connections

This partial save feature enables administrators to pre-configure connection information as a saved connection and

bundle it with the client application. For example, administrators can save a connection with the FQDN of the PCoIP

Connection Manager preset and then distribute this information to their deployed clients. As a result of this users

would be able to skip past the initial domain screen and advance directly to their user authentication screen.

The administrator can find and distribute the connection info file located at %APPDATA%\Teradici\PCoIP Client 

Connection Info.ini
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Multiple Desktops

This configuration enables you to see and access a selection of desktop environments each time

you connect. 

1. Enter the host address and name the connection 

2. Enter and save the Username 

Multiple Desktops
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Once you have done this each time you use this connection you will be presented with the list of

available desktops for that connection. 

Multiple Desktops
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Connecting to Teradici PCoIP Remote Workstation
Cards

You can connect to remote workstations with a Teradici PCoIP Remote Workstation Card and

PCoIP Host Software installed. Refer to System Requirements for supported versions.

Initial Workstation Configuration

Before you can connect to your remote workstation for the first time, a few things must be

configured on the host machine.

These configuration actions only need to be taken once on each remote workstation in your

system:

• Record the MAC address of the PCoIP Remote Workstation Card

Before you install the PCoIP Remote Workstation Card in the workstation, record the MAC

address of the PCoIP Remote Workstation Card as this will will enable you to log into the card

to configure the settings. Type https://pcoip-host-0030040de898.mydomain where

0030040de898 is the MAC address of your PCoIP Remote Workstation Card and mydomain is

the local domain of your network. This step is important as the host driver function is disabled

by default, so the host software will not pick up information about the PCoIP Remote

Workstation Card, such as the MAC address. The MAC address enables you to connect to the

PCoIP Remote Workstation Card to view the IP address and enable the host driver function. 

For more information on IP and MAC information relating to the PCoIP Remote Workstation

Card, see here.

• Install PCoIP Remote Workstation Card Agent

To connect to a remote workstation with a PCoIP Remote Workstation Card using a PCoIP

Software Client, the Remote Workstation Card Agent must be installed.

• Enable monitor emulation for the video ports on your remote workstation

If monitor emulation is not enabled, you may see blank gray screens when you connect from

the PCoIP Software Client.

Connecting to Teradici PCoIP Remote Workstation Cards
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To enable monitor emulation, log in to the card’s Administrator Web Interface (AWI) and select

Enable Monitor Emulation on Video Port n from the Configuration > Monitor Emulation menu.

For more information, see the Tera2 PCoIP Zero Client Firmware 4.x and Remote Workstation

Card Firmware 4.9 Administrators' Guide.

• Disable temporal dithering

Temporal dithering causes blurriness, heavy packet loss, and high CPU usage on the PCoIP

Software Client machine. See Should I disable the dithering feature of my graphics card in a

remote workstation environment? (KB 15134-207) for more information.

• Linux workstations: configure PCoIP Host Software to Start Automatically

To configure the PCoIP host software to start automatically, log into the workstation using a

PCoIP Zero Client or directly from a local mouse and keyboard, and modify the workstation

startup script to launch the PCoIP host software. For details, see Installing PCoIP Host

Software Binary RPM in the PCoIP® Host Software for Linux User Guide.

Connecting to a Remote Workstation Card

Once the remote workstation is properly configured, you can connect to it from the PCoIP

Software Client.

Connecting to a Remote Workstation Card via a PCoIP Software Client

The direct connection from the PCoIP Software Client to the PCoIP Remote Workstation Card is

supported through the PCoIP Remote Workstaton Agent software which needs to be installed on

the workstation where the PCoIP Remote Workstation Card is installed. You must have a Remote

Workstation Card Agent installed to enable a connection to a Remote Workstation Card.

Both the NIC of the workstation and the NIC of the PCoIP Remote Workstation card need to be

accessible by the PCoIP Software Client. They can be on different local networks as long as both

are accessible by the PCoIP Software Client. If they are both behind a NAT and accessed by the

Workstation configuration is required before connecting

If you experience connection problems or degraded performance, make sure that the workstation is configured as

described in Initial Workstation Configuration.
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PCoIP Software Client then the PCoIP Remote Workstation Card Agent must send the NAT'ed

address to the PCoIP Software Client when connecting.

Connecting to a PCoIP Remote Workstation Card through the command line

You can have a direct connection to a PCoIP Remote Workstation card, from a PCoIP Software

Client, without requiring a PCoIP Remote Workstation Card agent installed on the host machine if

you connect via the command line by using the  option with the IP address of your

PCoIP Remote Workstation Card, for example:

10.11.12.13 is the IP address of the PCoIP Remote Workstation Card.

Connecting to a remote workstation with a Teradici PCoIP Remote Workstation

Card installed:

1. Double-click the PCoIP Client desktop icon, alias, or program file (PCoIPClient) to launch the

application.

Cloud Access Software Subscription

You need to have a valid Cloud Access Software Subscription to use the PCoIP Remote Workstation Card Agent.



Direct Connection to PCoIP Remote Workstation Cards

PCoIP brokering can now be used to connect to the Remote Workstation Card. You can still connect to a non-

brokered Remote Workstation Card by connecting to the FQDN of the workstation instead of the FQDN of the Remote

Workstation Card. This method of connection requires the Remote Workstation Card Agent to be installed on the

workstation



--hard-host

pcoip_client.exe --hard-host 10.11.12.13

Connecting to a PCoIP Remote Workstation Card through the command line
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2. In the Host Address and Code box, enter the fully-qualified computer name or IP address of

the remote workstation or the address of the PCoIP broker, for example Cloud Access

Manager or a third-party broker.

3. Optional: In the Connection Name box, enter a name for your connection. This field accepts

any Unicode character.

4. Click NEXT.

5. If your desktop is locked upon connection and requires you to enter Ctrl+Alt+Delete to log in,

select Connection > Send CTRL-ALT-DEL from the PCoIP Software Client menu bar.

PCoIP Remote Workstation Card Feature Compatibility

Not all features with the Software Client are fully supported when connecting to a PCoIP Remote

Workstation Card. The following section outlines these limitations against certain features.

Audio: PCoIP Remote Workstation Card uses a hardware based audio protocol which is not fully

supported on the Software Client.

The Connection Information can be saved

If you provide a connection name now, you will have the option of saving the connection after you are

authenticated. Saved connections can be quickly recalled later, without manually re-entering connection

information.



A short interface delay is normal

When a session is first connected, it may take a few seconds before you can take control of the keyboard and

mouse. This is normal behavior.
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Topology: Single display configuration will work. There may be disruptions in the forms of black

bars or scroll bars on the client if the PCoIP Remote Workstation Card does not support the

display configuration on the client. The worst instance of this disruption will occur for some client

configurations that don't work with the hard host configuration.

USB: Connecting USB devices to the PCoIP Remote Workstation Card is not supported.

Performance: Updated to support PCoIP Ultra are not applicable to the RWC.

Connecting Remotely using NAT or VPN

The same principles that apply for PCoIP Zero Clients apply to PCoIP Software Clients when

connecting to multiple hosts through a WAN. Connections from a PCoIP Software Client to a

Remote Workstation Card across a WAN will require a VPN or NAT setup with enterprise level

NATing devices. For information on how to connect a PCoIP Software Client to a Remote

Workstation Card installed in a Windows host computer, see here.

Connecting Remotely using NAT or VPN
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Connecting to a USB Device

Remote Windows hosts using the PCoIP Standard Agent or the PCoIP Graphics Agent can use

USB devices that are attached to the client. When you connect a local USB device to your remote

host it will be disabled on the client machine.

USB device connections do not persist across multiple PCoIP sessions. You must connect your

USB device each time you connect.

USB Bridging of Webcams

USB Webcams can be redirected to a remote PCoIP Agent for Windows from PCoIP Software

Clients for Windows and/or Linux. You need to ensure that the upstream bandwidth of the

connection is sufficient to support streaming video. This feature works with a limited set of USB

cameras, including the Logitech C920. It is limited to video resolutions of less than 480p.

PCoIP Agent needs to be configured to enable USB redirection

The USB menu will only show up if the PCoIP Agent has been configured to enable USB redirection and a USB device

has been detected by the PCoIP Client.



ePadLink Signature Pad and some Wacom tablets are connected via local termination

If you are using an ePadLink Signature Pad and certain Wacom tablets they can be connected via local termination.

You do not need to carry out any other steps to establish this connection. For information on which Wacom tablets

are locally terminated, see Wacom Tablets.



NoMachine and TGX Remote Desktop USB Driver Compatibility

PCoIP Clients are not compatible with NoMachine and No Machine USB drivers. For information on how to uninstall

NoMachine USB drivers, see here. PCoIP Client USB redirection is not compatible with TGX Remote Desktop. Please

uninstall the TGX application if you require USB redirection. 
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The following section outlines how to connect a USB device:

1. Attach the USB device you want to connect.

2. Select Connection > USB Devices from the PCoIP Software Client menu.

• A list of USB devices connected to your client machine appears. Integrated USB devices,

such as built-in cameras on laptops, will appear in this list along with devices you have

plugged in yourself.

• Some devices will identify themselves only as USB Device.

3. Click Connect beside the USB device you want to use.

USB Bridging of Webcams
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Disconnecting a USB Device

1. Select Connection > USB Devices from the PCoIP Software Client menu.

2. Click Disconnect beside the USB device you want to disconnect. 

Connecting to Human Interface Devices

Most Human Interface Devices (HIDs), such as keyboards and mice, are automatically handled by the PCoIP Software

Client and don't appear on in this list even if they use a USB connection.

If you need to connect a Human Interface Device that can't be locally processed, like a 3D mouse or a Wacom tablet,

enable the Show Human Interface Devices checkbox to reveal the device in the USB device list and click its Connect

button.

You may also have to complete additional configuration steps or install drivers on the host machine.
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USB Auto-Forward for Non-HID Devices

A HID is a device class definition that enables a generic USB driver to support devices such as

keyboards, mice, tablets, controllers, etc. Non-HID devices primarily run on the PS/2 port transport.

Automatic bridging enables you to auto bridge all non-HID USB devices by using the 

 command line parameter.

USB Vendor ID/Product ID Auto-Forward

You can automatically forward up to 20 USB devices to the host at the start of the session by

calling the PCoIP client executable with  and the required VID/PID pairs. 

USB VID/PID Auto-forwarding workflow

Devices that are auto-forwarded will appear in the USB Devices dialog box, enabling users to

connect or disconnect them from the host. The following is an example of how this command

would look with the VID/PID values: 

The following rules apply to VID and PID values:

• VID/PID values are comma-separated: ,

usb-auto-

forward

vidpid-auto-forward

VID/PID Pairs

You can locate the VID/PID pairs from the PCoIP Client logs which are placed in %localappdata%

\Teradici\PCoIPClient\logs. When getting the VID/PID pairs from the log you need to strip 0x from the IDs,

and use the rest of the ID when running the  command. As outlined in the following example: 

The VID/PID pair in this scenario would be 18a5,0302.



vidpid-auto-forward

2040-12-12T20:36:46.117Z e0f9e9e9e-866f-1038-test-ac87a3007abc LVL:2 RC:   0        
MGMT_USB :Device 0x00010001 VID=0x**18a5**PID=0x**0302**
2040-12-12T20:36:46.117Z e0f9e9e9e-866f-1038-test-ac87a3007abc LVL:2 RC:   0        
MGMT_USB :Device 0x00010001 Name=TEST Serial=012345ABCDE pp=000222222

pcoip_client.exe --vidpid-auto-forward "1234,5678 abcd,efgh"

xxx yyy

USB Auto-Forward for Non-HID Devices
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• VID/PID pairs are space-separated:  

• VID/PID pairs with invalid values will be discarded. Discarded rules appear in the event log.

• Up to 20 devices will be passed; if more than 20 are attempted, the first 20 will be accepted

and rest ignored. Ignored rules appear in the event log.

aaa,bbb ccc,ddd

USB Vendor ID/Product ID Auto-Forward
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Configuring Wacom Tablets

This section outlines how to configure your Wacom tablet through the PCoIP Client session. There

are two available features within the PCoIP Client that can be used to configure the monitor

display and orientation. This only applies to locally terminated Wacom Tablets.

Tablet Monitor

The Tablet Monitor feature enables you to select the monitor you want to use with your Wacom

tablet. You can change between using a pen or mouse and select the orientation position.

To configure Tablet Monitor settings:

1. Select View from the in-session options bar.

2. Check the Tablet Monitor option.

3. Open Wacom Tablet Properties from the Wacom Desktop Center.

4. Select your device, tool and application.

5. Select your screen area from the dropdown menu.

Configuring Wacom Tablets
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Tablet Orientation Left-handed

The left-handed orientation configures the tablet for a left-handed orientation. Select ExpressKeys

Right for a left-handed orientation, and ExpressKeys Left for a right-handed orientation. Rotate the

tablet to the desired orientation.

To configure Tablet Orientation:

1. Select View from the in-session options bar.

2. Check the Tablet Orientation Left-handed option.

3. Open Wacom Tablet Properties from the Wacom Desktop Center.

4. Select your device, tool and application.

5. Select your orientation from the dropdown menu.

Tablet Orientation Left-handed
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Using Saved Connections

Once you have saved a connection, you can use it to reconnect easily.

To reconnect using your saved connection:

1. Click the button for the saved connection. The button label displays the connection name you

assigned when you configured the connection. 

2. To see the connection address, hover your mouse over the saved connection. Hovering over a

saved virtual desktop will also show the desktop name. 

Using Saved Connections
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3. To edit or delete a saved connection, click the configure button on the right, and then select

the desired option from the popup menu. 

4. If you have saved multiple connections, click the desired one to reconnect. If you have multiple

saved connections use the search bar to locate the connection and scroll down to find it. 

5. Any time you wish to connect to a new workstation, just click NEW CONNECTION to return to

the main screen, and then enter the connection details.

To reconnect using your saved connection:
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Filtering through your saved connections

You can use the search bar to now filter saved connections based on there connection names. 

Filtering through your saved connections
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Reset Virtual Desktop

The following section outlines how to reset a saved desktop in the PCoIP Client. You can reset to a

virtual desktop by following the steps outlined below:

1. Click the configure button and select Edit from the popup menu. 

2. Click NEXT on the initial saved connection screen. 

Reset Virtual Desktop
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3. Enter your access credentials and click SAVE. 

4. Click the configure button and select Reset. If the Reset option is not available, then this

feature is not supported by the Connection Manager. 

Reset Virtual Desktop
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Disconnecting a Session

To disconnect a PCoIP session, select the Connection > Disconnect menu option.

Quitting the PCoIP Client application will also disconnect the current session.

Session Reconnection

If a network interruption is detected, the PCoIP session enters a reconnecting phase. In this phase

the client will show you the network reconnecting dialog which indicates that there is a network

issue and that the client is trying to reconnect and re-establish the PCoIP session. You can click 

disconnect to cancel the attempted reconnect and disconnect the session completely. If the

reconnection is successful, the notification dialog will disappear and the session will be restored, if

not, the session will be disconnected completely.

Quickly disconnect from a session

To quickly disconnect from a session, press Ctrl + Alt + F12.



Disconnecting a Session
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Changing the PCoIP Software Client Window Mode

You can use the PCoIP Software Client in full-screen or windowed mode. Full-screen mode is

recommended in most cases.

Activating Full Screen Modes

The PCoIP Software Client provides two full-screen modes: one monitor and all monitors.

To switch from windowed mode to full-screen mode:

• To use one full-screen display, select View > Show Fullscreen One Monitor.

All open windows and applications will be moved to a single full-screen display. This is equivalent

to disconnecting all but one monitor from a physical host.

• To use all available full-screen displays, select View > Show Fullscreen All Monitors.

This mode shows full-screen displays on all client monitors.

To switch from Fullscreen One Monitor to Fullscreen All Monitors mode:

1. Reveal the menu bar by moving the mouse cursor to the top of a client display.

2. Select View > Show Fullscreen All Monitors.

To switch from Fullscreen All Monitors to Fullscreen One Monitor mode:

1. Reveal the menu bar by moving the mouse cursor to the top of a client display.

2. Select View > Show Fullscreen One Monitor.

Keyboard shortcut

You can also enter full-screen mode by pressing Ctrl+Alt+Enter while in windowed mode. The shortcut will activate

whichever full-screen mode was used last, or all monitors if no previous selection was made.
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Minimizing the PCoIP Software Client from a Full-screen Mode

To minimize a software client in full-screen mode:

1. Reveal the menu bar by moving the mouse cursor to the top of any display.

2. Select View > Minimize Client.

Activating Windowed Mode

To switch from full-screen mode to windowed mode:

1. Reveal the menu bar by moving the mouse cursor to the top of any display.

2. Select View > Leave Fullscreen.

Persistent Display Topology

Depending on the display topology mode you have selected, for example Fullscreen One Monitor, if you disconnect

and then reconnect to the session, it will maintain that same mode upon reconnection. The state and mode will be

preserved.



Keyboard shortcut

You can also minimize the client by pressing Ctrl+Alt+m while in any full-screen mode.



Keyboard shortcut

You can also enter windowed mode by pressing Ctrl+Alt+Enter while in any full-screen mode.
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Detect Monitors

The detect monitors feature enables you to add and remove displays from the desktop through the

PCoIP Clients while in an active session.

Adding a Display

The following steps outline how to add a display to your desktop through the PCoIP Client:

1. Connect a new monitor to the client.

2. From the desktop, click View.

3. Click Detect Monitors.

The displays on the remote desktop will be extended to include the new monitor.

Removing a Display

The following steps outline how to remove a display from your desktop.

1. Disconnect a monitor from the client.

2. From the desktop, click View.

3. Click Detect Monitors.

You will no longer see the monitor that you have disconnected from the client.

Detect Monitors
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Enhanced Audio and Video Synchronization

Enhanced Audio and Video Synchronization (A/V Sync) provides improved full-screen video

playback, reducing the difference in delays between the audio and video channels and smoothing

frame playback on the client. This improves lip sync and reduces video frame drops for video

playback.

This feature introduces a small lag in user interaction responsiveness when enabled. Using

enhanced audio and video synchronization will reduce the maximum frame rate.

Enhanced A/V Sync is enabled on a per-display basis, so you can dedicate individual displays to

playback without impacting responsiveness on the others.

To use enhanced A/V Sync:

1. If you are in full-screen mode, reveal the menu bar on the display you want to enhance by

moving the mouse cursor to the top of the screen.

2. On the display you want to enhance select View>Enhanced A/V Sync to toggle the enhanced

sync mode.

PCoIP Ultra AV-Lock Tech Preview

PCoIP Ultra AV-Lock enables regulated synchronization of audio and video frames and reduces dropped video frames

during video playback. For some use cases, such as video editorial, audio video synchronization is critical, including

under various network conditions (such as congestion) that may be present with remote work. For information, and to

get access to this preview, go to the Teradici Tech Preview Program page.



Persistent Display Topology

The Enhanced Audio and Video Synchronization feature is persistent across sessions from the same client, provided

that the display topology has not changed.
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Sending a Ctrl-Alt-Del Command

To send the Ctrl-Alt-Del keyboard command to a remote workstation, select the Connection >

Send CTRL-ALT-DEL menu option.

Sending a Ctrl-Alt-Del Command
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Changing the Language

In addition to English, the PCoIP Software Client also supports these languages: Chinese

(Simplified), French, German, Italian, Japanese, Korean, Portuguese (Brazil), Portuguese (Europe),

Russian, Spanish, and Turkish. During installation, you can select one of the supported languages.

To change the language after installation:

In Control Panel > Region and Language > Formats tab, select another language in the Format list.

To change the language on the command line

Alternatively, the language can be set with the  parameter on the command line:

The following table lists the available language translations and codes:

locale

pcoip-client --locale <locale-code>

Language Code

German de

Spanish es

French fr

Italian it

Japanese ja

Korean ko

Portuguese (EU) pt

Portuguese (Brazil) pt_BR

Russian ru
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Language Code

Turkish tr

Chinese (Simplified) zh_CN

Chinese (Traditional) zh_TW

Changing the Language
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System Precedence

The following section outlines the scope precedence commands between the System Scope and 

User Scope. If you are updating individual user settings then the user scope locations and

parameters can be followed. Due to this order of precedence where by the system scope setting

takes precedence over the user scope setting, a change in the user settings may not take effect if

the system scope setting has been updated.

System Scope

User Scope

To add a new key append key=value to the .ini file:

If you are creating a new file, the format of the file should be:

For example:

%PROGRAMDATA%\Teradici\Teradici PCoIP Client.ini

%APPDATA%\Teradici\Teradici PCoIP Client.ini

[General]
<key>=<value>

[General]
security_mode=2

System Precedence
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PCoIP Client Parameters

The following table outlines command line parameters that are available to use and customize:

Short Long                                                     Default Description

-? Display help message. Set to false by default.

-v Print version information. Set to false by default.

-u Username sent to Connection Broker.

-p Password sent to Connection Broker.

-d Domain sent to Connection Broker.

-b Connection broker URL.

-l Unset force log level (will override config/registry)

-w False run inside a window.

-f False run in full-screen mode. The default is to run in windowed

mode.

-s Security mode.

- Set locale.

- Disable USB.

-h Hard host URL. This option is ignored if connection-broker is

provided

Do no re-enter the pre-session after leaving the in-session.

Auto-forward all non-HID devices.

--help

--version

--username

--password

--domain

--connection-broker

--log-level

--windowed

--fullscreen

--security-mode

--locale

--disable-usb

--hard-host

--quit-after-disconnect

--usb-auto-forward

PCoIP Client Parameters
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For example, running the  command will have the following format:

For additional information on customizable in-session options, see Customizable Session

Features.

Short Long                                                     Default Description

String of VID, PID hex values separated by a comma. For example

0x540c 0x04ce wont work, you need to write 0x540c,0x04ce.

Blocks specific VID,PIDs from autoforward regardless of whether

the  parameter or the USB dialog is used.

Disables the PCoIP Client menubar. Prevents the user from

accessing menu functionality.

Disables session hot keys.

Activates full-screen mode from windowed mode in a PCoIP

Session.

Locks the resolution of your host application displays.

Enables scaling on the PCoIP Client without having to specify the

desktop resolution.

Maintains the aspect ratio between the host and client.

Sets the resolution of the client monitor to the native resolution

when the session client's launched.

Enables users to select which desktop they which to use.

--vidpid-auto-forward

--vidpid-black-list

usb-auto-forward

--disable-menubar

--disable-hotkeys

--full-screen

--set-host-resolution

--enable-scaling

--maintain-aspect-ratio

--force-native-resolution

--desktop

--help

"c:\Program Files (x86)\Teradici\PCoIP Client\bin\pcoip_client.exe" --help

PCoIP Client Parameters
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Launching PCoIP Software Client with a URI

It is possible to launch the PCoIP Software Client with a URI. The Teradici URI uses JSON Web

Tokens (JWT). For more information on the use of JWT, see here. The URI is defined as the

following:

When additional parameters are passed through the encoded JWT a session can be launched:

The table below details supported optional JWT payload claims:

Below is an example of a JWT payload:

pcoip://[broker]/connect[?data={jwt}]

Field Description Optional vs

Required

pcoip:// Scheme registered to operating system so that PCoIP Client can be

launched

Required

broker Broker through which a PCoIP session is supposed to be brokered through Optional

/

connect

Connecting to a PCoIP Client with the parameters defined in "?data" Required

?data Query parameter to store a jwt encoded user credentials Optional

Claim Description

usr Username

dom Domain

vm Virtual machine/resource name

sid Broker JSESSIONID

{
    "usr": "username",

Launching PCoIP Software Client with a URI
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The following is an example of a connect command:

    "dom": "mydomain.com",
    "vm": "mydesktopname"
}

pcoip://fake.broker.com/connect?
data=eyJhbGciOiJIUzI1NiIsInR5cCI6IkpXVCJ9.eyJ1c3IiOiJ1c2VybmFtZSIsImRvbSI6Im15ZG9tYWluLmNvbSIsInZtIj

Launching PCoIP Software Client with a URI
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HID Local Termination Blacklist

Local Termination of Wacom tablets provides the best user experience in networks with high

latency, however some features of the tablet may not be fully supported with local termination. A

HID local termination blacklist has been added to override the preferred local termination mode. 

Devices on the blacklist would be bridged to the remote desktop. To enable the HID local

termination blacklist, add the following setting to %APPDATA%\Teradici\Teradici PCoIP Client.ini.

The vendor and product IDs are separated by a comma and multiple devices are separated by a

space.

For more information on USB Vendor ID/Product ID Auto-Forward, see here.

Troubleshooting HID Local Termination Blacklist

The following lines should appear in the PCoIP Agent log if a device is using HID local termination:

localtermination_black_list "vid,pid vid2,pid2"

pcoip server log: `LVL:2 RC: 0 MGMT_KMP :Client added HoIP device (id:0x000a0005) 
with vendor id=0x056a, product id=0x0391`
pcoip client log: `LVL:2 RC: 0 MGMT_USB :HoIP supported device detected (Vid: 
0x056a, Pid: 0x0391), using HoIP protocol for local termination'

HID Local Termination Blacklist
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PCoIP High Performance Client

The PCoIP Software Client has a high performance mode that can be enabled through the 

 file. The  file can be found at 

%appdata%\Teradici\Teradici PCoIP Client.ini.

The PCoIP High Performance client enables higher frame rates with fewer dropped frames than

the default PCoIP Software Client. This mode is especially beneficial for 4K video workloads up to

30fps.

To enable the high performance mode of the PCoIP Client you need to edit the 

 file. To enable the high performance mode, set the following value:

You can use the  parameter which will automatically forward USB

peripherals such as Wacom Tablets and Game Pads, see here.

Additional information on the high performance client:

• Compatible for fullscreen, all monitors only. You cannot use windowed mode.

• Limited menu options are available.

Teradici PCoIP Client.ini Teradici PCoIP Client.ini

PCoIP High Performance Client Limitations

The PCoIP High Performance Client is recommended for customers wishing to optimize the presentation of high

frame rate content such as video or animations. Teradici does not recommend using the PCoIP High Performance

Client for majority use cases, and instead it is a case specific enhancement at this time as it contains certain

limitations.



Teradici PCoIP 

Client.ini

%appdata%\Teradici\Teradici PCoIP Client.ini

enable_native_opengl=1

--vidpid-auto-forward

PCoIP High Performance Client
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Menu Options on the High Performance Client

The following menu options are available on the High Performance Client:

• Teradici PCoIP Client

◦ Quit Teradici PCoIP Client

• Connection

◦ Send Ctrl+Alt+Del

◦ Disconnect (To disconnect use ctrl-alt-~ )

• View

◦ Minimize Client (You can minimize the client by using ctrl-alt-m )

◦ Tablet Monitor

◦ Tablet Orientation Left-handed

◦ PCoIP Ultra AVLock

Statistics Overlay on the High Performance Client

The statistics overlay feature on the High Performance Client displays the following information:

• Codec: This reports the current PCoIP encoding that is in use. Possible values for this include

PCoIP Ultra CPU, PCoIP Ultra GPU and PCoIP.

• Encoding: This reports the color space that is being used to encode the information. PCoIP

and PCoIP Ultra CPU offload will report RGB 8:8:8 which means full 8 bit RGB pixels are being

used. For PCoIP Ultra GPU optimization, either YUV 4:4:4 or YUV 4:2:0 will be used, depending

on the system configuration.

• HW Decode: This reports whether or not the PCoIP Client is decoding the frames using built-in

GPU hardware decoding.

• FPS: This reports the current frames per second that are presented on the PCoIP Client.

The image below is an example of a statistics overlay on the High Performance Client:

Menu Options on the High Performance Client

© 2021 Teradici 69



To enable the statistics overlay of the PCoIP Client you have to edit the 

 file. To edit the file you can use tools like "vi", "nano" or "vim"/ Please see the manuals

of your prefered text editor on how to use it. To enable the statistics overlay on the high

performance client, add the following to the  file:

To toggle visibility of the statistics overlay press CTRL+Win` .

Teradici PCoIP 

Client.ini

Teradici PCoIP Client.ini

enable_native_opengl_stats_overlay=1

Statistics Overlay on the High Performance Client
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Custom Logo in Pre-Session

The PCoIP Software Client can be configured to place a custom logo beside the PCoIP logo at the

bottom right corner of the PCoIP Software Client login dialog. For best results, the logo should be a

.png file with a transparent background, and ideally should be 245x100 or smaller. The image must

be named customlogo.png.

• Windows location: %PROGRAMDATA%/Teradici/PCoIPClient/

Custom Logo in Pre-Session
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Customizable Session Features

The following PCoIP session features can be customized:

• Session Menu Bar Visibility

• Disable Hot Keys

• Windowed or Fullscreen Mode

• Set Host Resolution

• Image Scaling

• Maintain Aspect Ratio

• Force Native Resolution

Session Menu Bar Visibility

To enhance the user experience the PCoIP Session Client enables the menu bar by default,

however some use cases may require that it be disabled, or hidden, in order to prevent the user

from accessing menu functionality. To disable the menu bar feature use the parameter disable-

menubar .

Disable Hot Keys

To improve usability, session hot keys, such as Ctrl+Delete+F12 (which disconnects a PCoIP

session) are available to users by default. The parameter for this feature is disable-hotkeys .

Examples show command-line usage

The examples shown here invoke the PCoIP Software Client via the command line. You can also set these priorities

when invoking the PCoIP Software Client programmatically.



Customizable Session Features
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Windowed or Fullscreen Mode

Depending on your application needs, you can display the PCoIP session in either windowed or

fullscreen mode. Fullscreen mode allows the display topology to support multiple monitors as an

extended desktop; windowed mode gives you the flexibility to display multiple application windows

in parallel and switch between them quickly. Windowed mode improves the user experience, as

well as resulting in an increase in performance. Windowed mode is the default mode, and to

activate fullscreen mode use the full-screen  parameter.

Set Host Resolution

Normally, the session client opens with arbitrary window dimensions. In some cases, you may

wish to lock the resolution of your host application displays. This ensures the user’s viewing

experience is consistent across different monitors and their native resolutions. The parameter for

this feature is set-host-resolution .

• Host Resolution Limitations: It is only possible to specify one target resolution for all displays.

The host resolution will not perform to its optimal capability if you have monitors with different

resolutions.

Image Scaling

The image scaling feature enables scaling on the client without having to specify the desktop

resolution. You can apply image scaling when the resolution of the client monitor is not the same

as the resolution provided by the host. This feature provides a smoother process for image scaling

on the client. The parameter for this feature is enable-scaling .

Maintain Aspect Ratio

If the host and client aspect ratios do not match, and this parameter is not used then the display

will be stretched to fit. The parameter for this feature is maintain-aspect-ratio . If the native

aspect ratios of the host’s display and the client’s display do not match, the host’s aspect ratio will

be preserved and will appear in the client with black bars either on the sides or top and bottom of

the display.

Windowed or Fullscreen Mode
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Force Native Resolution

The resolution of the client monitor can be set to the native resolution when the session client is

launched using the force-native-resolution  parameter.

Force Native Resolution
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PCoIP Software Client Security Modes

The PCoIP Software Client uses certificates to verify the identity of the host to which it connects.

The security mode is configured by the  setting in the Teradici PCoIP Client

configuration file, which is described next. Three security mode options are available:

• security_mode=0: verification is not required A red, unlocked padlock icon appears on the

client login screen.

• security_mode=1: warn but allow (default) If a certificate cannot be verified, an 'untrusted

server' warning displays and a red, unlocked padlock icon appears on the client login screen.

Users still have the option of connecting.

This mode is used if  is not set in the configuration file.

• security_mode=2: full verification is required Users cannot connect unless a certificate can be

verified.

Setting the Security Mode

Use the following procedure to set the PCoIP Software Client's security mode.

To set the security mode for the PCoIP Software Client:

1. Close the PCoIP Software Client.

2. Open a Windows Explorer window and navigate to %appdata%\Teradici.

3. Using a text editor, open Teradici PCoIP Client.ini.

4. Add the line  to the file, where  is your desired security

option (0, 1, or 2).

security_mode

security_mode

PCoIP sessions are always encrypted

Your PCoIP session is still encrypted and secure if you connect with security mode 0 or 1. The red padlock icon

indicates that the certificate presented by the host is not signed by a trusted certificate authority in the client’s

certificate store, not that the session is insecure.



security_mode=<value> <value>

PCoIP Software Client Security Modes
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5. Save the file.

Setting the Security Mode
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Installing the Internal Root CA Certificate in a PCoIP
Client

Your root CA certificate must be installed in any PCoIP client that will be used to connect to the

PCoIP Agent.

Installing Root CA Certificates in the PCoIP Software Client for
Windows

To import the root CA certificate for the PCoIP Software Client for Windows:

1. Copy your root CA certificate file (*.crt) to a directory reachable by your Windows client.

2. Open the Microsoft Management Console on the agent machine:

a. Press + r  to open the run dialog

b. type mmc and press Enter .

Root CA Certificate must have a .crt extension

You must change the root CA certificate's extension from .pem to .crt before installing it on a PCoIP Software Client.



Windows must trust your root certification authority

When you use your own private key and certificate, you must add your internal root CA certificate to the Windows

Trusted Root Certification Authorities certificate store on the client computer.

Users without a trusted root CA will receive an Unable to get local issuer certificate error and fail to connect.



Active Directory group policies

For information on using Active Directory Group Policy to distribute certificates to client computers, see http://

technet.microsoft.com/en-us/library/cc772491.aspx.
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3. Add the Certificates snap-in:

a. Select File > Add/Remove Snap-in.

b. Select Certificates from the Available snap-ins list and then click Add.

c. Select My user account and then click Finish.

d. Click OK.

4. Import the root CA certificate:

a. Expand Certificates - Current User.

b. Right-click on Trusted Root Certification Authorities, select All Tasks > Import from the

context menu, and then click Next.

c. Use the Browse button to navigate to the directory where your root CA certificate is

located and select your root CA certificate.

d. Click Open and then Next.

e. Select the option to place all certificates in the Trusted Root Certification Authorities

certificate store.

f. Click Next and then Finish.

g. At the security warning, click Yes.

After the certificate installs successfully, it appears in the Trusted Root Certification Authorities >

Certificates list.

Installing Root CA Certificates in the PCoIP Software Client for Windows
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Contacting Support

If you encounter problems installing or using Teradici technology, you can:

• Check for updated release notes, which may address the issue you are experiencing. Release

notes are published on Teradici Support.

• Browse the Teradici Knowledge Base.

• Submit a support ticket.

Contacting Support
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The Teradici Community Forum

The PCoIP Community Forum allows users to have conversations with other IT professionals to

learn how they resolved issues, find answers to common questions, have peer group discussions

on various topics, and access the Teradici PCoIP Technical Support Service team. Teradici staff

are heavily involved in the forums.

To join the Teradici community, visit the Teradici Community Forum.

The Teradici Community Forum
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Creating a Technical Support File

Teradici may request a support file from your system in order to troubleshoot and diagnose PCoIP

issues.

To create a support file:

1. Open a PowerShell command prompt.

2. Set the PowerShell execution policy to enable the script to run:

3. Launch the support bundler:

The support file will be created and placed in $env:ProgramData\Teradici\Support\. A

new File Explorer window will open with the generated support file selected.

Set-ExecutionPolicy -Scope Process -ExecutionPolicy Bypass

& 'C:\Program Files (x86)\Teradici\PCoIP Client\bin\pcoip-client-support-
bundler.ps1'

Creating a Technical Support File
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Checking the PCoIP Software Client Software
Release

The PCoIP Software Client pre-session window contains an About button in the lower left of the

window. Click this button and then select About from the popup menu to display the PCoIP

Software Client software release version.

From either client, you can also select the Teradici PCoIP Client > About Teradici PCoIP Client

menu to display the software release version from within a PCoIP session.

Checking the PCoIP Software Client Software Release
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About menu item only appears when the client is in session

The About Teradici PCoIP Client menu item only appears when the client is in session. The menu item is not available

from the pre-session GUI.



Checking the PCoIP Software Client Software Release
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Troubleshooting the Software Client for Windows

This section demonstrates using Software Client for Windows log files to troubleshoot problems

you may encounter with your Software Client for Windows.

Software Client for Windows logs are text (.txt) files that contain system and session information

about your connection. They are useful for troubleshooting problems. A new log file is created

each time you use a Software Client for Windows to initiate a PCoIP session.

Client logs are placed in %localappdata%\Teradici\PCoIPClient\logs.

If you experience a problem, recreate the issue, generate a support bundle and contact Teradici

Support. You can also check the Teradici PCoIP Community Forum for troubleshooting

information about this product.

Troubleshooting the Software Client for Windows
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Session Log IDs

The Software Client for Windows creates a unique session ID when a new session is established,

and distributes that ID to all components in the system. When PCoIP components generate log

messages, they are prefixed by this unique session ID, allowing administrators and support to

easily group events by session across multiple components:

For example:

Log messages that do not pertain to a specific session will show a string of zeroes in place of the

session log ID number.

yyyy-mm-ddThh:mm:ss.ffffffZ xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx > …

2015-11-06T08:01:18.688879Z 4208fb66-e22a-11d1-a7d7-00a0c982c00d > …

Session Log IDs
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Setting Log Levels

You can set log levels to determine the level of details provided in the log. Log levels range from 0

to 3, where 0 provides the least information and 3 provides the most information.

To set log levels:

1. From the command prompt, navigate to C:\Program Files (x86)\Teradici\PCoIP

Client\bin.

2. Enter the following command:

where  is lowercase L and  is desired the log level (1, 2, or 3).

pcoip_client.exe -l x

l x

Setting Log Levels
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Reconnecting a PCoIP Session

If a network interruption is detected, the PCoIP session enters a reconnecting phase. In this phase

the client will show you the network reconnecting dialog which indicates that there is a network

issue and that the client is trying to reconnect and re-establish the PCoIP session. You can click 

disconnect to cancel the attempted reconnect and disconnect the session completely. If the

reconnection is successful, the notification dialog will disappear and the session will be restored, if

not, the session will be disconnected completely.

Reconnecting a PCoIP Session
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Recovering a USB Driver with the PCoIP Software
Client

When using USB drivers on the PCoIP Software Client for Windows you can sometimes encounter

issues around versioning of the USB hub filter, as displayed in the error message below:

If you encounter this issue or another issue relating to your USB driver, Teradici recommends

carrying out the following steps:

1. Uninstall the PCoIP Client.

2. Reboot your machine.

3. Open the Registry Editor editor.

Recovering a USB Driver with the PCoIP Software Client
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4. Search for fusbhub under HKLM 

5. Remove the registry key which is the item in the left pane with the folder icon, in this case it is

the fuhub key, containing fusbhub. If you cannot remove this registry key note the .inf file

name associated with the registry entry. The .inf file name usually starts with oem, for

example oem9.inf. Open the commandline and run the following prompt: 

6. Keep repeating step 5 until fusbhub is completely removed from the registry editor.

7. Reboot your machine.

8. Install the PCoIP Client.

pnputil -f -d oem9.inf

Recovering a USB Driver with the PCoIP Software Client
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